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• ASAvの VMware機能のサポート（1ページ）
• ASAvと VMwareの前提条件（3ページ）
• ASAvと VMwareのガイドラインと制限事項（4ページ）
• ASAvソフトウェアの開梱と第 0日用コンフィギュレーションファイルの作成（7ペー
ジ）

• VMware vSphere Web Clientを使用した ASAvの導入（10ページ）
• VMware vSphereスタンドアロンクライアントおよび第 0日用構成を使用した ASAvの導
入（15ページ）

• OVFツールおよび第 0日用構成を使用した ASAvの導入（16ページ）
• ASAvコンソールへのアクセス（17ページ）
• vCPUまたはスループットライセンスのアップグレード（20ページ）
• ESXi構成でのパフォーマンスの向上（21ページ）

ASAvの VMware機能のサポート
次の表に、ASAvの VMware機能のサポートを示します。

表 1 : ASAvの VMware機能のサポート

注釈サポート（あり/なし）説明機能

¯
ありクローニング中にVM

の電源がオフになりま

す。

コールドクローン

VMwareのガイドライ
ンを参照してくださ

い。

Yes動的リソースのスケ

ジューリングおよび分

散電源管理に使用され

ます。

DRS
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注釈サポート（あり/なし）説明機能

¯なし追加時にVMが動作し
ています。

ホット追加

¯なしクローニング中にVM
が動作しています。

ホットクローン

¯なし取り外し中にVMが動
作しています。

ホットリムーブ

使用には注意が必要で

す。トラフィックが失

われる可能性がありま

す。フェールオーバー

が発生することがあり

ます。

ありVMが数秒間フリーズ
します。

Snapshot

¯ありVMが一時停止され、
その後再開します。

一時停止と再開

¯なしVMの自動配置が可能
になります。

vCloud Director

¯あり移行中にVMの電源が
オフになります。

VMの移行

共有ストレージを使用

します。vMotionに関
するガイドライン（

5ページ）を参照し
てください。

YesVMのライブマイグ
レーションに使用され

ます。

VMotion

ASAv VM障害の場合
は、ASAvフェール
オーバーを使用しま

す。

なしVMの HAに使用され
ます。

VMware FT

ASAv VM障害の場合
は、ASAvフェール
オーバーを使用しま

す。

ありESXiおよびサーバの
障害に使用されます。

VMware HA

ASAv VM障害の場合
は、ASAvフェール
オーバーを使用しま

す。

なしVM障害に使用されま
す。

VMハートビートの
VMware HA
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注釈サポート（あり/なし）説明機能

¯
ありVMを導入するために

使用されます。

VMware vSphereスタ
ンドアロンWindows
クライアント

¯ありVMを導入するために
使用されます。

VMware vSphere Web
Client

ASAvと VMwareの前提条件
VMware vSphere Webクライアント、vSphereスタンドアロンクライアント、または OVFツー
ルを使用して ASAvを導入できます。システム要件については、『Cisco ASA Compatibility』
を参照してください。

vSphere標準スイッチのセキュリティポリシー

vSphereスイッチについては、レイヤ2セキュリティポリシーを編集して、ASAvインターフェ
イスによって使用されるポートグループに対してセキュリティポリシーの例外を適用できま

す。次のデフォルト設定を参照してください。

•無差別モード：拒否

• MACアドレスの変更：許可

•不正送信：許可

次のASAv設定については、これらの設定の変更が必要な場合があります。詳細については、
vSphereのマニュアルを参照してください。

表 2 :ポートグループのセキュリティポリシーの例外

トランスペアレントファイアウォー

ルモードルーテッドファイアウォールモード

セキュリティの例

外 フェールオーバー

フェールオーバー

なしフェールオーバー

フェールオーバー

なし

承認承認<任意><任意>無差別モード

承認<任意>承認<任意>MACアドレスの
変更

承認承認承認<任意>不正送信
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ASAvと VMwareのガイドラインと制限事項
ASAvを導入する前に、次のガイドラインと制限事項を確認します。

OVFファイルのガイドライン

導入対象に基づいて、asav-vi.ovfファイルまたは asav-esxi.ovfファイルを選択します。

• asav-vi：vCenterに導入する場合

• asav-esxi：ESXiに導入する場合（vCenterなし）

• ASAvOVFの導入では、ローカリゼーション（非英語モードでのコンポーネントのインス
トール）はサポートされません。ご自身の環境のVMwarevCenterとLDAPサーバがASCII
互換モードでインストールされていることを確認してください。

• ASAvをインストールして VMコンソールを使用する前に、キーボードを [United States
English]に設定する必要があります。

• ASAvを導入すると、2つの異なる ISOイメージが ESXiハイパーバイザにマウントされ
ます。

•マウントされた最初のドライブには、vSphereによって生成されたOVF環境変数が備
わってます。

•マウントされた 2番目のドライブは day0.isoです。

ASAv仮想マシンが起動した後、両方のドライブのマウントを解
除できます。ただし、 [Connect at Power On]がオフになっている
場合でも、ドライブ 1（OVF環境変数を使用）は、ASAvの電源
をオフ/オンにするたびに常にマウントされます。

注目

ハイアベイラビリティガイドラインのためのフェールオーバー

フェールオーバー配置の場合は、スタンバイ装置が同じライセンス権限付与を備えていること

を確認してください（たとえば、両方の装置が 2Gbpsの権限付与であることなど）。

ASAvを使用してハイアベイラビリティペアを作成する場合は、データインターフェイスを
各ASAvに同じ順序で追加する必要があります。完全に同じインターフェイスが異なる順序で
各 ASAvに追加されると、ASAvコンソールにエラーが表示される可能性があります。また、
フェールオーバー機能にも影響が出ることがあります。

重要
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IPv6のガイドライン

VMware vSphere Web Clientを使用して ASAv OVFファイルを最初に導入する場合は、管理イ
ンターフェイスに IPv6アドレスを指定できません。ASDMまたは CLIを使用して、IPv6アド
レッシングを後で追加できます。

vMotionに関するガイドライン

• VMwareでは、vMotionを使用する場合、共有ストレージのみを使用する必要があります。
ASAvの導入時に、ホストクラスタがある場合は、ストレージをローカルに（特定のホス
ト上）、または共有ホスト上でプロビジョニングできます。ただし、ASAvを vMotionを
使用して別のホストに移行する場合、ローカルストレージを使用するとエラーが発生しま

す。

スループット用のメモリと vCPUの割り当てとライセンス

• ASAvに割り当てられたメモリのサイズは、スループットレベルに合わせたものです。異
なるスループットレベルのライセンスを要求する場合を除いて、[Edit Settings]ダイアログ
ボックスのメモリ設定または vCPUハードウェア設定は変更しないでください。アンダー
プロビジョニングの場合、パフォーマンスに影響する場合があり、オーバープロビジョニ

ングの場合、ASAvによりリロードが行われることが警告されます。待機期間（100～
125%のオーバープロビジョニングの場合は 24時間、125%以上の場合は 1時間）の後、
ASAvはリロードします。

メモリまたは vCPUハードウェア設定を変更する必要がある場合
は、ASAvのライセンスに記載されている値のみを使用してくだ
さい。VMwareが推奨するメモリ構成の最小値、デフォルト値、
および最大値は使用しないでください。

（注）

場合によっては、ASAv5のメモリが枯渇状態になります。これは、AnyConnectの有効化
やファイルのダウンロードなど、特定リソースの利用が多い場合に発生することがありま

す。自動的な再起動に関するコンソールメッセージやメモリ使用量に関する重大なsyslog
が、メモリ枯渇の状態を示します。このような場合、1.5 GBメモリの VMに ASAv5を導
入できます。1 GBから 1.5 GBに変更するには、VMの電源をオフにして、メモリを変更
し、VMの電源を再度オンにします。

CPU予約

•デフォルトで、ASAvのCPU予約は1000MHzです。共有、予約、および制限の設定（[Edit
Settings] > [Resources] > [CPU]）を使用することによって、ASAvに割り当てられたCPUリ
ソースの量を変更できます。ASAvがより低い設定で必要なトラフィック負荷が課されて
いる状況でその目的を果たすことができる場合は、CPU予約の設定を 1000 Mhz未満にす
ることができます。ASAvによって使用される CPUの量は、それが動作しているハード
ウェアプラットフォームだけでなく、それが行っている作業のタイプと量によっても異な

ります。
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仮想マシンの [Performance]タブの [Home]ビューに配置された [CPU Usage (MHz)]チャー
トから、すべての仮想マシンに関する CPU使用率をホストの視点で確認できます。ASAv
が標準的なトラフィック量を処理しているときの CPU使用率のベンチマークを設定すれ
ば、その情報を CPU予約の調整時の入力として使用できます。

詳細については、VMwareから発行されている『CPU Performance Enhancement Advice』を
参照してください。

•リソース割り当ておよびオーバープロビジョニングまたはアンダープロビジョニングされ
ているリソースを表示するには、ASAvの show vmおよび show cpuコマンドか、ASDM
の [Home] > [Device Dashboard] > [Device Information] > [Virtual Resources]タブまたは
[Monitoring] > [Properties] > [System Resources Graphs] > [CPU]ペインを使用します。

UCS Bシリーズハードウェアにおけるトランスペアレントモードに関するガイドライン

MACフラップが、Cisco UCS Bシリーズハードウェアのトランスペアレントモードで動作す
る ASAv設定で発生することがあります。MACアドレスがさまざまな場所で出現した場合、
パケットはドロップされます。

VMware環境にトランスペアレントモードで ASAvを導入する場合にMACフラップを回避す
るには、次のガイドラインを参考にしてください。

• VMware NICチーミング：UCS BシリーズにトランスペアレントモードでASAvを導入す
る場合、内部および外部インターフェイスに使用するポートグループにはアクティブアッ

プリンクを 1つだけ設定し、そのアップリンクは同じである必要があります。vCenterで
VMware NICチーミングを設定します。

NICチーミングの設定方法の詳細については、VMwareドキュメントを参照してください。

• ARPインスペクション：ASAvで ARPインスペクションを有効にし、受信インターフェ
イスでMACおよび ARPエントリを静的に設定します。ARPインスペクションと有効化
の詳細については、『Cisco ASA Series General Operations Configuration Guide』を参照して
ください。

CD/DVDドライブの接続を解除した後、ASAvが到達不能になる

[Edit Settings]ダイアログボックスを使用して、CD/DVDドライブをASAv仮想マシンに接続し
たり、接続を解除したりできます。[VM Hardware]パネルからデバイスを接続したり、接続を
解除したりできます。

ASAvに到達できなくなる可能性があるため、ASAvの CD/DVDドライブの接続を解除しない
ことをお勧めします。

重要

回避策

接続を解除された CD/DVDドライブが原因で ASAvが到達不能状態になっている場合は、次
の手順を実行します。
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1. [Monitor]タブをクリックし、[Notifications]をクリックします。

2. 次のようなアラートを探します。「The guest operating system has locked the CD-ROM door
and is probably using the CD-ROM, which can prevent the guest from recognizing media changes.
If possible, eject the CD-ROM from inside the guest before disconnecting. Disconnect anyway and
override the lock?」

3. アラートを確認します。プロンプトが表示されたら、ポップアップで [Yes]を選択し、[OK]
をクリックします。

4. ASAv仮想マシンに再度到達可能になっている必要があります。

その他のガイドラインと制限事項

• ESXi 5.0を実行している場合、vSphere Web Clientは ASAv OVFの導入ではサポートされ
ません。代わりに、vSphereクライアントを使用してください。

ASAvソフトウェアの開梱と第 0日用コンフィギュレー
ションファイルの作成

ASAvを起動する前に、第 0日（Day 0）用のコンフィギュレーションファイルを準備できま
す。このファイルは、ASAvの起動時に適用される ASAvの設定を含むテキストファイルで
す。この初期設定は、「day0-config」というテキストファイルとして指定の作業ディレクトリ
に格納され、さらに day0.isoファイルへと処理されます。この day0.isoファイルが最初の起動
時にマウントされて読み取られます。第0日用コンフィギュレーションファイルには、少なく
とも、管理インターフェイスをアクティブ化するコマンドと、公開キー認証用 SSHサーバを
設定するコマンドを含める必要がありますが、すべての ASA設定を含めることもできます。
空の day0-configを含むデフォルトの day0.isoがリリースとともに提供されています。day0.iso
ファイル（カスタム day0またはデフォルトの day0.iso）は、最初の起動中に使用できなければ
なりません。

始める前に

この例では Linuxが使用されていますが、Windowsの場合にも同様のユーティリティがありま
す。

•初期導入時に自動的に ASAvをライセンス許諾するには、Cisco Smart Software Managerか
らダウンロードした Smart Licensing Identity（ID）トークンを「idtoken」というテキスト
ファイルに格納し、第0日用コンフィギュレーションファイルと同じディレクトリに保存
します。

•トランスペアレントモードで ASAvを導入する場合は、トランスペアレントモードで実
行される既知のASAコンフィギュレーションファイルを、第0日用コンフィギュレーショ
ンファイルとして使用する必要があります。これは、ルーテッドファイアウォールの第

0日用コンフィギュレーションファイルには該当しません。
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• ISOイメージが ESXiハイパーバイザにどのようにマウントされるかの詳細については、
ASAvと VMwareのガイドラインと制限事項（4ページ）の OVFファイルのガイドライ
ンを参照してください。

手順

ステップ 1 ZIPファイルを Cisco.comからダウンロードし、ローカルディスクに保存します。

https://www.cisco.com/go/asa-software

Cisco.comのログインおよびシスコサービス契約が必要です。（注）

ステップ 2 ファイルを作業ディレクトリに解凍します。ディレクトリからファイルを削除しないでくださ
い。次のファイルが含まれています。

• asav-vi.ovf：vCenterへの導入用。

• asav-esxi.ovf：vCenter以外への導入用。

• boot.vmdk：ブートディスクイメージ。

• disk0.vmdk：ASAvのディスクイメージ。

• day0.iso：day0-configファイルおよびオプションの idtokenファイルを含む ISO。

• asav-vi.mf：vCenterへの導入用のマニフェストファイル。

• asav-esxi.mf：vCenter以外への導入用のマニフェストファイル。

ステップ 3 「day0-config」というテキストファイルに ASAvの CLI設定を記入します。3つのインター
フェイスの設定とその他の必要な設定を追加します。

最初の行はASAのバージョンで始める必要があります。day0-configは、有効なASA構成であ
る必要があります。day0-configを生成する最適な方法は、既存の ASAまたは ASAvから実行
コンフィギュレーションの必要な部分をコピーすることです。day0-config内の行の順序は重要
で、既存の show running-configコマンド出力の順序と一致している必要があります。

例：

ASA Version 9.4.1
!
console serial
interface management0/0
nameif management
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
interface gigabitethernet0/0
nameif inside
security-level 100
ip address 10.1.1.2 255.255.255.0
no shutdown
interface gigabitethernet0/1
nameif outside
security-level 0
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ip address 198.51.100.2 255.255.255.0
no shutdown
http server enable
http 192.168.1.0 255.255.255.0 management
crypto key generate rsa modulus 1024
username AdminUser password paSSw0rd
ssh 192.168.1.0 255.255.255.0 management
aaa authentication ssh console LOCAL
call-home
http-proxy 10.1.1.1 port 443
license smart
feature tier standard
throughput level 2G

ステップ 4 （任意）Cisco Smart Software Managerにより発行された Smart License IDトークンファイルを
コンピュータにダウンロードします。

ステップ 5 （任意）ダウンロードファイルから IDトークンをコピーし、IDトークンのみを含む「idtoken」
というテキストファイルに保存します。

この IDトークンによって、Smart Licensingサーバに ASAvが自動的に登録されます。

ステップ 6 テキストファイルを ISOファイルに変換して仮想CD-ROMを生成します。

例：

stack@user-ubuntu:-/KvmAsa$ sudo genisoimage -r -o day0.iso day0-config idtoken
I: input-charset not specified, using utf-8 (detected in locale settings)
Total translation table size: 0
Total rockridge attributes bytes: 252
Total directory bytes: 0
Path table size (byptes): 10
Max brk space used 0
176 extents written (0 MB)
stack@user-ubuntu:-/KvmAsa$

ステップ 7 day0.iso用に Linuxで新しい SHA1値を計算します。

例：

openssl dgst -sha1 day0.iso
SHA1(day0.iso)= e5bee36e1eb1a2b109311c59e2f1ec9f731ecb66 day0.iso

ステップ 8 新しいチェックサムを作業ディレクトリの asav-vi.mfファイルに含め、day0.iso SHA1値を新し
く生成された値で置き換えます。

例：

SHA1(asav-vi.ovf)= de0f1878b8f1260e379ef853db4e790c8e92f2b2
SHA1(disk0.vmdk)= 898b26891cc68fa0c94ebd91532fc450da418b02
SHA1(boot.vmdk)= 6b0000ddebfc38ccc99ac2d4d5dbfb8abfb3d9c4
SHA1(day0.iso)= e5bee36e1eb1a2b109311c59e2f1ec9f731ecb66

ステップ 9 ZIPファイルを解凍したディレクトリに day0.isoファイルをコピーします。デフォルト（空）
の day0.isoファイルが上書きされます。

このディレクトリからVMが導入される場合は、新しく生成された day0.iso内の構成が適用さ
れます。

VMwareを使用した ASAvの導入
9

VMwareを使用した ASAvの導入

ASAvソフトウェアの開梱と第 0日用コンフィギュレーションファイルの作成



VMware vSphere Web Clientを使用した ASAvの導入
このセクションでは、VMware vSphere Web Clientを使用してASAvを導入する方法について説
明します。Webクライアントには、vCenterが必要です。vCenterがない場合は、「VMware
vSphereスタンドアロンクライアントおよび第 0日用構成を使用した ASAvの導入」、または
「OVFツールおよび第 0日用構成を使用した ASAvの導入」を参照してください。

• vSphere Web Clientへのアクセスとクライアント統合プラグインのインストール（10ペー
ジ）

• VMware vSphere Web Clientを使用した ASAvの導入（10ページ）

vSphereWebClientへのアクセスとクライアント統合プラグインのイン
ストール

この項では、vSphere Web Clientにアクセスする方法について説明します。また、ASAvコン
ソールアクセスに必要なクライアント統合プラグインをインストールする方法についても説明

します。一部のWebクライアント機能（プラグインなど）は、Macintoshではサポートされて
いません。完全なクライアントのサポート情報については、VMwareのWebサイトを参照して
ください。

手順

ステップ 1 ブラウザから VMware vSphere Web Clientを起動します。

https://vCenter_server:port/vsphere-client/

デフォルトでは、portは 9443です。

ステップ 2 （1回のみ）ASAvコンソールへのアクセスを可能にするため、クライアント統合プラグイン
をインストールします。

1. ログイン画面で、[Download the Client Integration Plug-in]をクリックしてプラグインをダウ
ンロードします。

VMwareを使用した ASAvの導入
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2. ブラウザを閉じてから、インストーラを使用してプラグインをインストールします。

3. プラグインをインストールしたら、vSphere Web Clientに再接続します。

ステップ 3 ユーザ名とパスワードを入力し、[Login]をクリックするか、[UseWindows session authentication]
チェックボックスをオンにします（Windowsのみ）。

VMware vSphere Web Clientを使用した ASAvの導入
ASAvを導入するには、VMware vSphere Webクライアント（または vSphereクライアント）、
およびオープン仮想化フォーマット（OVF）のテンプレートファイルを使用します。シスコの
ASAvパッケージを展開するには、vSphere Webクライアントで [Deploy OVF Template]ウィ
ザードを使用します。このウィザードは、ASAv OVFファイルを解析し、ASAvを実行する仮
想マシンを作成して、パッケージをインストールします。

ウィザードの手順のほとんどは、VMwareに対し標準のものです。Deploy OVF Templateの詳
細については、VMware vSphere Web Clientのオンラインヘルプを参照してください。

始める前に

ASAvを導入する前に、vSphere（管理用）に少なくとも 1つのネットワークを設定しておく必
要があります。

VMwareを使用した ASAvの導入
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手順

ステップ 1 ASAv ZIPファイルを Cisco.comからダウンロードし、PCに保存します。

http://www.cisco.com/go/asa-software

Cisco.comのログインおよびシスコサービス契約が必要です。（注）

ステップ 2 vSphere Web Clientの [Navigator]ペインで、[vCenter]をクリックします。

ステップ 3 [Hosts and Clusters]をクリックします。

ステップ 4 ASAvを導入するデータセンター、クラスタ、またはホストを右クリックして、[Deploy OVF
Template]を選択します。
[Deploy OVF Template]ウィザードが表示されます。

ステップ 5 ウィザード画面の指示に従って進みます。

ステップ 6 [Setup networks]画面で、使用する各ASAvインターフェイスにネットワークをマッピングしま
す。

ネットワークはアルファベット順になっていない可能性があります。ネットワークを見つける

ことが非常に困難な場合は、[Edit Settings]ダイアログボックスからネットワークを後で変更で
きます。導入後、ASAvインスタンスを右クリックし、[Edit Settings]を選択して、[Edit Settings]
ダイアログボックスにアクセスします。ただし、この画面には ASAvインターフェイス IDは
表示されません（ネットワークアダプタ IDのみ）。次のネットワークアダプタ IDと ASAv
インターフェイス IDの対応一覧を参照してください。

ASAvインターフェイス IDネットワークアダプタ
ID

Management 0/0ネットワークアダプタ1

GigabitEthernet 0/0ネットワークアダプタ2

GigabitEthernet 0/1ネットワークアダプタ3

GigabitEthernet 0/2ネットワークアダプタ4

GigabitEthernet 0/3ネットワークアダプタ5

GigabitEthernet 0/4ネットワークアダプタ6

GigabitEthernet 0/5ネットワークアダプタ7

GigabitEthernet 0/6ネットワークアダプタ8

GigabitEthernet 0/7ネットワークアダプタ9

GigabitEthernet 0/8ネットワークアダプタ
10
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すべての ASAvインターフェイスを使用する必要はありませんが、vSphere Web Clientではす
べてのインターフェイスにネットワークを割り当てる必要があります。使用しないインター

フェイスについては、ASAv設定内でインターフェイスを無効のままにしておくことができま
す。ASAvを導入した後、任意で vSphere Web Clientに戻り、[Edit Settings]ダイアログボック
スから余分なインターフェイスを削除することができます。詳細については、vSphere Web
Clientのオンラインヘルプを参照してください。

フェールオーバー/HA配置では、GigabitEthernet 0/8がフェールオーバーインターフェ
イスとして事前設定されます。

（注）

ステップ 7 インターネットアクセスに HTTPプロキシを使用する場合は、[Smart Call Home Settings]領域
でスマートライセンスのプロキシアドレスを設定する必要があります。このプロキシは、一

般に Smart Call Homeにも使用されます。

ステップ 8 フェールオーバー/HA配置では、[Customize]テンプレート画面で次を設定します。

•スタンバイ管理 IPアドレスを指定します。

インターフェイスを設定する場合、同じネットワーク上のアクティブ IPアドレスとスタ
ンバイ IPアドレスを指定する必要があります。プライマリ装置が故障すると、セカンダ
リ装置はプライマリ装置の IPアドレスとMACアドレスを引き継ぎ、トラフィックを通過
させます。現在スタンバイになっている装置が、スタンバイの IPアドレスとMACアドレ
スを引き継ぎます。ネットワークデバイスは、MACと IPアドレスの組み合わせについて
変更を認識しないため、ネットワーク上のどのような場所でも ARPエントリが変更され
たり、タイムアウトが生じたりすることはありません。

• [HA Connection Settings]領域で、フェールオーバーリンクを設定します。

フェールオーバーペアの 2台の装置は、フェールオーバーリンク経由で常に通信して、
各装置の動作ステータスを確認しています。GigabitEthernet 0/8がフェールオーバーリン
クとして事前設定されています。同じネットワーク上のリンクに対するアクティブな IP
アドレスとスタンバイの IPアドレスを入力します。

ステップ 9 ウィザードが完了すると、vSphere Web ClientはVMを処理します。[Global Information]領域の
[Recent Tasks]ペインで [Initialize OVF deployment]ステータスを確認できます。

この手順が終了すると、[Deploy OVF Template]完了ステータスが表示されます。

VMwareを使用した ASAvの導入
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その後、ASAv VMインスタンスがインベントリ内の指定されたデータセンターの下に表示さ
れます。

ステップ 10 ASAv VMがまだ稼働していない場合は、[Power on the virtual machine]をクリックします。

VMwareを使用した ASAvの導入
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ASDMで接続を試行したりコンソールに接続を試行する前に、ASAvが起動するのを待ちま
す。ASAvが初めて起動すると、OVFファイルから提供されたパラメータを読み込み、それら
をASAvシステム構成に追加します。その後、起動プロセスが自動的に再開され、稼働を開始
します。この二重起動プロセスは、初めてASAvを導入した場合にのみ発生します。起動メッ
セージを確認するには、[Console]タブをクリックして、ASAvコンソールにアクセスします。

ステップ 11 フェールオーバー/HA配置の場合は、この手順を繰り返してセカンダリ装置を追加します。次
のガイドラインを参照してください。

•プライマリ装置と同じスループットレベルを設定します。

•プライマリ装置とまったく同じ IPアドレス設定を入力します。両方の装置のブートスト
ラップ設定は、プライマリまたはセカンダリとして装置を識別するパラメータを除いて同

一にします。

次のタスク

Cisco認証局に正常に登録するには、ASAvをインターネットアクセスが必要です。インター
ネットアクセスを実行して正常にライセンス登録するには、導入後に追加の設定が必要になる

ことがあります。

VMware vSphereスタンドアロンクライアントおよび第 0
日用構成を使用した ASAvの導入

ASAvを導入するには、VMware vSphereクライアントおよびオープン仮想化フォーマット
（OVF）のテンプレートファイル（vCenterへ導入する場合は asav-vi.ovfまたは vCenter以外
へ導入する場合は asav-esxi.ovf）を使用します。シスコの ASAvパッケージを展開するには、
vSphereクライアントで [Deploy OVF Template]ウィザードを使用します。このウィザードは、
ASAv OVFファイルを解析し、ASAvを実行する仮想マシンを作成して、パッケージをインス
トールします。

ウィザードの手順のほとんどは、VMwareに対し標準のものです。[Deploy OVF Template]ウィ
ザードの詳細については、VMware vSphereクライアントのオンラインヘルプを参照してくだ
さい。

始める前に

• ASAvを導入する前に、vSphere（管理用）に少なくとも 1つのネットワークを設定してお
く必要があります。

• ASAvソフトウェアの開梱と第 0日用コンフィギュレーションファイルの作成（7ペー
ジ）の手順に従って、第 0日用構成を作成します。

VMwareを使用した ASAvの導入
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手順

ステップ 1 VMware vSphereクライアントを起動し、[File] > [Deploy OVF Template]を選択します。

[Deploy OVF Template]ウィザードが表示されます。

ステップ 2 asav-vi.ovfファイルを解凍した作業ディレクトリを参照し、それを選択します。

ステップ 3 [OVF Template Details]画面が表示されます。次の画面に移動します。カスタムの第 0日用コン
フィギュレーションファイルを使用する場合は、構成を変更する必要はありません。

ステップ 4 最後の画面に導入設定の要約が表示されます。[Finish]をクリックしてVMを導入します。

ステップ 5 ASAvに電源を投入し、VMwareコンソールを開いて、2回目の起動を待機します。

ステップ 6 ASAvに SSH接続し、必要な構成を完了します。第 0日用コンフィギュレーションファイル
に必要なすべての構成がされていない場合は、VMwareコンソールを開いて、必要な構成を完
了します。

これで、ASAvは完全に動作可能な状態です。

OVFツールおよび第 0日用構成を使用した ASAvの導入
このセクションでは、第 0日用コンフィギュレーションファイルを必要とする OVFツールを
使用した ASAvの導入方法について説明します。

始める前に

• OVFツールを使用して ASAvを導入する場合は、day0.isoファイルが必要です。ZIPファ
イルで提供されるデフォルトの空の day0.isoファイルを使用するか、または、生成しカス
タマイズした第 0日用コンフィギュレーションファイルを使用できます。第 0日用コン
フィギュレーションファイルの作成方法については、ASAvソフトウェアの開梱と第 0日
用コンフィギュレーションファイルの作成（7ページ）を参照してください。

• OVFツールが LinuxまたはWindows PCにインストールされ、ターゲット ESXiサーバに
接続できることを確認します。

手順

ステップ 1 OVFツールがインストールされていることを確認します。

例：

linuxprompt# which ovftool

ステップ 2 必要な導入オプションを指定した .cmdファイルを作成します。

例：

VMwareを使用した ASAvの導入
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linuxprompt# cat launch.cmd
ovftool \
--name="asav-941-demo" \
--powerOn \
--deploymentOption=ASAv30 \
--diskMode=thin \
--datastore=datastore1 \
--acceptAllEulas \
--net:Management0-0="Portgroup_Mgmt" \
--net:GigabitEthernet0-1="Portgroup_Inside" \
--net:GigabitEthernet0-0="Portgroup_Outside" \
--prop:HARole=Standalone \
asav-esxi.ovf \
vi://root@10.1.2.3/

ステップ 3 cmdファイルを実行します。

例：

linuxprompt# ./launch.cmd

ASAvに電源を投入し、2回目の起動を待機します。

ステップ 4 ASAvに SSH接続し、必要に応じて構成を完了します。さらに構成が必要な場合は、ASAvに
対して VMwareコンソールを開き、必要な構成を適用します。

これで、ASAvは完全に動作可能な状態です。

ASAvコンソールへのアクセス
ASDMを使用する場合、トラブルシューティングに CLIを使用する必要がある場合がありま
す。デフォルトでは、組み込みの VMware vSphereコンソールにアクセスできます。または、
コピーアンドペーストなどのより優れた機能を持つネットワークシリアルコンソールを設定

できます。

• VMware vSphereコンソールの使用

•ネットワークシリアルコンソールポートの設定

VMware vSphereコンソールの使用
初期設定またはトラブルシューティングを行うには、VMware vSphereWebClientにより提供さ
れる仮想コンソールから CLIにアクセスします。後で Telnetまたは SSHの CLIリモートアク
セスを設定できます。

始める前に

vSphere Web Clientでは、ASAvコンソールアクセスに必要なクライアント統合プラグインを
インストールします。

VMwareを使用した ASAvの導入
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手順

ステップ 1 VMware vSphere Web Clientで、インベントリの ASAvインスタンスを右クリックし、[Open
Console]を選択します。または、[Summary]タブの [Launch Console]をクリックします。

ステップ 2 コンソールでクリックして Enterを押します。注：Ctrl + Altを押すと、カーソルが解放されま
す。

ASAvがまだ起動中の場合は、起動メッセージが表示されます。

ASAvが初めて起動すると、OVFファイルから提供されたパラメータを読み込み、それらを
ASAvシステム構成に追加します。その後、起動プロセスが自動的に再開され、稼働を開始し
ます。この二重起動プロセスは、初めて ASAvを導入した場合にのみ発生します。

ライセンスをインストールするまで、スループットは 100 Kbpsに制限されるため、
予備接続テストを実行できます。ライセンスは、通常の操作に必要です。ライセンス

をインストールするまで、次のメッセージがコンソールで繰り返し表示されます。

Warning: ASAv platform license state is Unlicensed.
Install ASAv platform license for full functionality.

（注）

次のプロンプトが表示されます。

ciscoasa>

このプロンプトは、ユーザEXECモードで作業していることを示します。ユーザEXECモード
では、基本コマンドのみを使用できます。

ステップ 3 特権 EXECモードにアクセスします。

例：

ciscoasa> enable

次のプロンプトが表示されます。

Password:

ステップ 4 Enterキーを押して、次に進みます。デフォルトでは、パスワードは空白です。以前にイネー
ブルパスワードを設定した場合は、Enterを押す代わりにこれを入力します。

プロンプトが次のように変化します。

ciscoasa#

設定以外のすべてのコマンドは、特権EXECモードで使用できます。特権EXECモードからコ
ンフィギュレーションモードに入ることもできます。

特権モードを終了するには、disableコマンド、exitコマンド、または quitコマンドを入力し
ます。

ステップ 5 グローバルコンフィギュレーションモードにアクセスします。

ciscoasa# configure terminal

プロンプトが次のように変化します。

ciscoasa(config)#
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グローバルコンフィギュレーションモードから ASAvの設定を開始できます。グローバルコ
ンフィギュレーションモードを終了するには、exitコマンド、quitコマンド、または endコマ
ンドを入力します。

ネットワークシリアルコンソールポートの設定

コンソールエクスペリエンスの向上のために、コンソールアクセスについて、ネットワーク

シリアルポートを単独で設定するか、または仮想シリアルポートコンセントレータ（vSPC）
に接続するように設定できます。各方法の詳細については、VMware vSphereのマニュアルを
参照してください。ASAvでは、仮想コンソールの代わりに、シリアルポートにコンソール出
力を送信する必要があります。この手順では、シリアルポートコンソールを有効にする方法

について説明します。

手順

ステップ 1 VMware vSphereでネットワークシリアルポートを設定します。VMware vSphereのマニュアル
を参照してください。

ステップ 2 ASAvで、「use_ttyS0」という名前のファイルを disk0のルートディレクトリに作成します。
このファイルには内容が含まれている必要はありません。この場所に存在することのみが必要

です。

disk0:/use_ttyS0

• ASDMから [Tools] > [File Management]ダイアログボックスを使用して、この名前で空の
テキストファイルをアップロードできます。

• vSphereコンソールで、ファイルシステム内の既存のファイル（任意のファイル）を新し
い名前にコピーできます。次に例を示します。

ciscoasa(config)# cd coredumpinfo
ciscoasa(config)# copy coredump.cfg disk0:/use_ttyS0

ステップ 3 ASAvをリロードします。

• ASDMから、[Tools] > [System Reload]を選択します。

• vSphereコンソールで reloadを入力します。

ASAvは vSphereコンソールへの送信を停止し、代わりにシリアルコンソールに送信しま
す。

ステップ 4 シリアルポートの追加時に指定した vSphereのホスト IPアドレスとポート番号に Telnet接続
するか、または vSPCの IPアドレスとポートに Telnet接続します。
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vCPUまたはスループットライセンスのアップグレード
ASAvは、使用できる vCPUの数に影響するスループットライセンスを使用します。

ASAvの vCPUの数を増やす（または減らす）場合は、新しいライセンスを要求して、その新
しいライセンスを適用し、新しい値と一致するように VMwareの VMプロパティを変更しま
す。

割り当てられた vCPUは、ASAv仮想 CPUライセンスまたはスループットライセンスと一致
している必要があります。RAMは、vCPU用に正しくサイズ調整されている必要があります。
アップグレードまたはダウングレード時には、この手順に従って、ライセンスと vCPUを迅速
に調整するようにします。永続的な不一致がある場合、ASAvは適切に動作しません。

（注）

手順

ステップ 1 新しいライセンスを要求します。

ステップ 2 新しいライセンスを適用します。フェールオーバーペアの場合、両方の装置に新しいライセン

スを適用します。

ステップ 3 フェールオーバーを使用するかどうかに応じて、次のいずれかを実行します。

•フェールオーバーあり：vSphere Web Clientで、スタンバイ ASAvの電源を切断します。
たとえば、ASAvをクリックしてから [Power Off the virtual machine]をクリックするか、ま
たは ASAvを右クリックして [Shut Down Guest OS]を選択します。

•フェールオーバーなし：vSphere Web Clientで、ASAvの電源を切断します。たとえば、
ASAvをクリックしてから [Power Off the virtual machine]をクリックするか、または ASAv
を右クリックして [Shut Down Guest OS]を選択します。

ステップ 4 ASAvをクリックしてから [Edit Virtual machine settings]をクリックします（または ASAvを右
クリックして [Edit Settings]を選択します）。

[Edit Settings]ダイアログボックスが表示されます。

ステップ 5 新しい vCPUライセンスの正しい値を確認するには、ASAvのライセンスにあるCPU要件とメ
モリ要件を参照してください。

ステップ 6 [Virtual Hardware]タブの [CPU]で、ドロップダウンリストから新しい値を選択します。

ステップ 7 [Memory]には、新しい RAMの値を入力します。

ステップ 8 [OK]をクリックします。

ステップ 9 ASAvの電源をオンにします。たとえば、[Power On the Virtual Machine]をクリックします。

ステップ 10 フェールオーバーペアの場合：

1. アクティブ装置へのコンソールを開くか、またはアクティブ装置でASDMを起動します。
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2. スタンバイ装置の起動が終了した後、スタンバイ装置にフェールオーバーします。

• ASDM：[Monitoring] > [Properties] > [Failover] > [Status]を選択し、[Make Standby]を
クリックします。

• CLI： failover active

3. アクティブ装置に対して、ステップ 3～ 9を繰り返します。

次のタスク

詳細については、「ASAvのライセンス」を参照してください。

ESXi構成でのパフォーマンスの向上
ESXiホストの CPU構成時の設定を調整することによって、ESXi環境内の ASAvのパフォー
マンスを向上させることができます。[Scheduling Affinity]オプションによって、仮想マシンの
CPUをホストの物理コア（およびハイパースレッディングが有効になっている場合のハイパー
スレッド）にどのように分散させるかを制御できます。この機能を使用すれば、各仮想マシン

を、指定したアフィニティセット内のプロセッサに割り当てることができます。

詳細については、以下の VMwareドキュメントを参照してください。

•「Administering CPU Resources」の章（『vSphere Resource Management』）。

•『Performance Best Practices for VMware vSphere』

• vSphere Clientのオンラインヘルプ。
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